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COPYRIGHT 
The information in this manual  and any software in this product remain the property of CES Wireless  
Technologies Corp. Duplication or disclosure is not permitted without the prior written consent of CES 
Wireless. CES Wireless reserves the right to change products, specifications, and installation data at any 
time, without notice.  All information contained in this document is carefully prepared and offered in good  
faith as a guide in the installation, operation, use and servicing of our products. Installers must insure that  
the  final  installation  operates  satisfactory,  within  relevant  regulatory  requirements.  We  accept  no 
responsibility for incorrect installations.

Windows XP, 2000, Vista and Windows7 are registered trademarks of Microsoft. All other trademarks are  
the property their respective owners.

A CES Wireless publication.  ©  Copyright CES Wireless 1997-2010

CHANGE LOG
Date Author Release Description
2012-04-17 Doug Hamilton 1.0 Initial Release
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1.0 Introduction
The GPS-207S_ExPwr Programming Software is used to program the GPS-207DC asset tracking device. 
This manual describes the installation of the software and the USB drivers required to communicate with 
the device. It also describes the options available within the software and how they effect the operation of 
the GPS-207DC including what effects different settings have on the estimated life of the battery.

Supported operating systems for the GPS207S_ExPwr include Windows 2000, Windows XP, Windows 
Vista and Windows7.
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2.0 GPS-207S_ExPwr Installation
CD Install: To install the GPS207S_ExPwr programming software insert CD-Soft1 into the CD-ROM 
drive of your computer. Navigate to the CD using Windows Explorer. On the CD navigate to the folder 
\Programming Software\GPS207S_ExPwr and double click on the setup.exe file.

Download Install: If the installation files were downloaded navigate to the folder where they were 
downloaded, using Windows Explorer, and double click on the setup.exe file.

The installation process is typical for most Windows applications. The first screen (below) will appear 
once the installation program has been initialized.

Figure 1: Installation Screen #1

Click on the Next button to advance to the second part of the installation process.

Figure 2: Installation Screen #2
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Read the License Agreement and select the “I accept the terms in the license agreement”. Then click on 
the next button to advance to the next screen. Note: If you do not agree to the terms if the license 
agreement then you cannot use the software.

Figure 3: Installation Screen #3

The next screen provides the capability to change the installation location of the GPS207S application. To 
accept the default location click on the next button. To change the location click on the Change button 
and navigate to the desired location. Click OK when done and click on the next button

The next screen will show the user details of the setup including the Setup Type, Application Installation 
Path and User information.

Figure 4: Installation Screen #4

Click on the install button to start the installation process. A screen similar to the one shown below will 
be displayed while the application is installed.
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Figure 5: Installation Screen #5

When the installation of the GPS207S is complete this final screen will be displayed. Click on the finish 
button to exit the installation application. You should now have shortcuts to the GPS207S on the 
computer desktop and on the start menu.

Figure 6: Installation Screen #6

Figure 7: Desktop Shortcut

© CES Wireless Technologies Corp – 2012    Page 8 of 28



3.0 USB Drivers Installation
The GPS207DC has a mini-USB style connector inside that is used to program the device. Open the 
GPS207DC per the instructions in the GPS-207/GPS-207DC User Manual. Connect the battery if it is not 
connected and swing it to the side of the enclosure. This will provide access to the USB connector.

Figure 8: Location of USB Connector inside of the GPS207

The communication process is handled via USB Drivers that create virtual com ports. These virtual com 
ports are used to communicate with the device. 

To install the drivers connect the GPS-207DC to the computer using a mini-USB to USB cable (CES P/N 
CBLxx). When the GPS207DC is connected to the computer for the first time, or to a different USB port, 
the user will be prompted to install the drivers.

The Windows operating system automatically detects the presence of a new USB device. The following 
screen will be displayed: 

Figure 9: Found New Hardware Wizard #1
Select No, not this time and click Next.
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Figure 10: Found New Hardware Wizard #2

Select Install from a list or specific location (Advanced) and click Next.

Figure 11: Found New Hardware Wizard #3

Click on the Include this location in the search check box. Browse to the folder where the USB drivers 
were installed. The default location is C:\Program Files\CES Wireless  
Technologies\GPS207S_ExPwr\Drivers. If the GPS207S_ExPwr installation path was changed during the 
software installation process the Drivers folder will be located in the selected location. 

Open the 32bit Drivers folder if using a 32 bit system. If using a 64 bit system open the 64bit Drivers 
folder.

Click Next.

The next screen shows the installation process.
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Figure 12: Found New Hardware Wizard #4

Once the installation of the driver for the Locosto USB device is complete the following screen will be 
displayed:

Figure 13: Found New Hardware Wizard #5

Click Finish and the next step in the USB device installation process will begin and the following screen 
will be displayed.
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Figure 14: Found New Hardware Wizard #6

Select No, not this time and click Next.

Figure 15: Found New Hardware Wizard #7

Select Install from a list or specific location (Advanced) and click Next.
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Figure 16: Found New Hardware Wizard #8

Click on the Include this location in the search check box. Browse to the folder where the USB drivers 
were installed. The default location is C:\Program Files\CES Wireless  
Technologies\GPS207S_ExPwr\Drivers. If the GPS207S_ExPwr installation path was changed during the 
software installation process the Drivers folder will be located in the selected location. 

Open the 32bit Drivers folder if using a 32 bit system. If using a 64 bit system open the 64bit Drivers 
folder. 

Click Next.

The following screen may be displayed.

Figure 17: Hardware Wizard, Windows Compatibility Test

If the above is displayed click on Continue Anyway and the software will be installed. The following 
screen will be displayed.
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Figure 18: Found New Hardware Wizard #9

Click Finish and the next step in the USB device installation process will begin and the following screen 
will be displayed.

Figure 19: Found New Hardware Wizard #10

Select No, not this time and click Next.
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Figure 20: Found New Hardware Wizard #11

Select Install from a list or specific location (Advanced) and click Next.

Figure 21: Found New Hardware Wizard #12

Click on the Include this location in the search check box. Browse to the folder where the USB drivers 
were installed. The default location is C:\Program Files\CES Wireless  
Technologies\GPS207S_ExPwr\Drivers. If the GPS207S_ExPwr installation path was changed during the 
software installation process the Drivers folder will be located in the selected location. 

Open the 32bit Drivers folder if using a 32 bit system. If using a 64 bit system open the 64bit Drivers 
folder.

Click Next.

The following screen may be displayed.
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Figure 22: Hardware Wizard, Windows Compatibility Test

If the above is displayed click on Continue Anyway and the software will be installed. The following 
screen will be displayed.

Figure 23: Found New Hardware Wizard #13

Click Finish to complete the installation of the USB drivers.
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4.0 Using the GPS207S_ExPwr
NOTE: Program the GPS-207DC before installing the SIM card. If reprogramming the device the SIM 
card should be removed before connecting the device to the computer.

To run the GPS207S_ExPwr programming software double click on the icon on the desktop or click on 
the Start button, select All Programs, select the CES Wireless Technologies folder and then click on 
GPS207S_ExPwr. The main form will be displayed.

Figure 24: GPS207S_ExPwr Main Form

4.1 Configure the Com Port
The first step in using the GPS207S_ExPwr is to configure the com port used to communicate with the 
GPS207DC.

4.1.1 Configuring the Com Port in the GPS207S_ExPwr
To configure the com port follow these steps. First, connect the GPS-207DC to the computer using the 
programming cable. Next, select Configure on the main menu and then select Com Port. The Select Com 
Port form will be displayed.
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Figure 25: Configure Menu

Figure 26: Select Com Port Form

To determine the proper Com Port to select click on the Scan Com Ports button. All available com ports 
will be displayed.

Select the Com Port number that has been assigned to the GPS207DC. In the image above this is COM17. 
Click OK. The selection will be stored in the application settings so that this only needs to be done once, 
or if the Com Port number changes (i.e. if the GPS207DC is connected to a different USB port).

The GPS207S_ExPwr is now configured to communicate with the GPS207DC.

4.2 File Menu
The File menu has four options on it. They are Open, Save, Save As and Exit.
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Figure 28: File Menu

4.2.1 Open
The Open menu selection provides the capability to open a saved configuration. To open a saved 
configuration select Open on the File menu. The Open dialog will be displayed.

Figure 29: Open GPS-207DC Config Dialog

Select the desired save configuration file (GPS207S configuration files have a .207 extension) and click 
Open. The file name of the configuration that was opened will be displayed in the GPS207S title bar.

Figure 30: GPS207S_ExPwr Title Bar Displaying Configuration File Name

4.2.2 Save
To save the current configuration select Save. If a configuration file was previously loaded or the current 
configuration was previously saved the current settings will be saved in the same file. Otherwise the Save 
As dialog will be displayed (refer to Section 4.2.3).

© CES Wireless Technologies Corp – 2012    Page 19 of 28



4.2.3 Save As
To save the current configuration in a new file select Save As. The Save GPS207 Config File form will be 
displayed.

Figure 31: Save GPS-207DC Config File

This is the typical Windows save file dialog. Navigate to the folder where you wish to save the file. Enter 
the file name and click on Save. The GPS207DC configuration file extension (.207) will automatically be 
appended onto the file name that was entered.

4.2.4 Exit
To exit the GPS207S_ExPwr application select File and then Exit. A prompt will be displayed to save the 
current configuration. It is highly recommended that the configuration be saved the first time the 
application is configured. Otherwise the Com Port will have to be configured again next time the 
application is used.

Figure 32: Save Current Configuration Dialog

Note – the GPS207S_ExPwr application can also be closed by clicking on the Exit button or the red X in 
the upper right corner of the main application form.
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4.3 Configure Menu
The Configure menu has three items on it. They are Com Port, Verify Connected and Connect New 
Device.

Figure 33: Configure Menu

4.3.1 Com Port
Refer to Section 4.1 for more information on how to configure the com port.

4.3.2 Verify Connected
To verify that a device is connected and that the com port has been properly configured select Verify  
Connected. 

If a device is connected and the com port has been properly configured the following dialog will be 
displayed.

Figure 34: Device is Connected Dialog

If a device is not connected or the com port has not been properly configured the following dialog will be 
displayed.

Figure 35: Device Not Connected or Com Port Not Properly Defined Dialog

4.3.3 Connect New Device
To connect a new device select the Connect New Device menu selection. This is important to do when 
programming multiple devices. Select this item and then disconnect the current device. Connect the new 
device.
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4.3.4 Verify System and Communication Parameters
This option provides the capability to verify that the parameters configured in the device match those 
configured in the software. A dialog will be displayed with the results.

4.4 Help Menu
There is one option on the Help menu: About.

4.4.1 About
Selecting About on the Help menu will cause the following form to be displayed. The form displays the 
copyright notice and the version number of the software as well as other important information.

Figure 37: Help About Form
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Click OK to close the form.

4.5 GPS207S_ExPwr Main Form
The main form of the GPS207S_ExPwr has three categories of programming parameters, a button to send 
the configuration to the GPS207DC, a progress bar and an exit button.

The different categories of programming parameters are

 Cellular System Parameters

 Communication Parameters

 GPS Configuration

Figure 38: GPS207S_ExPwr Main Form

4.5.1 Cellular System Parameters
The Cellular System Parameters contain the information necessary to connect to the cellular network. 
These values are supplied by the cellular provider. The parameters are APN, User Name and Password. 
Enter the information that was provided by the cellular provider. Known cellular parameters can be 
selected by clicking on the button next to the APN field. When this is done the Select Network form will 
be displayed.
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Figure 39: Select Network

If using one of the networks on the form click on it and click OK. This will cause the cellular parameters 
in the GPS207S_ExPwr main form to be updated with these values. If the network being used is not in the 
list you will have to contact the cellular provider to obtain them.

4.5.2 Communication Parameters
The Communication Parameters contain the information required to send data to Power-Trak3 or to 
FleetLinc. There are three fields: Unit Number, IP Address and Port.

4.5.2.1 Unit Number
The Unit Number is a unique identifier that enables the software to determine which device is which. It is 
very important that a unique number be programmed into each GPS-207DC. If using FleetLinc the Unit 
Number must be provided by CES Wireless Technologies. 

4.5.2.2 IP Address
The IP Address of the software (i.e. Power-Trak3 or FleetLinc) should be entered here. This is the IP 
Address to which the GPS-207DC will send packets to.

4.5.2.3 Port
The Port number used to communicate with the server should be entered here. This port should match the 
configuration of the software on the server. The default value is 2400.

4.5.3 GPS Configuration
The GPS-207DC can be configured to report as a static asset, where it will report only at the programmed 
intervals (one interval while on external power and one interval while on internal battery power). Or it 
can be programmed as a motion asset, where it can be programmed to report at one interval while 
stationary or a different interval while in motion. In addition, the GPS-207DC can be programmed to 
report at different rates based upon its use of external or internal battery power.
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4.5.3.1 GPS Reporting Type
There are two selections for the GPS Reporting Type. They are Static Asset and In Motion. Select the 
desired type based upon the asset that is to be monitored.

4.5.3.2 Static Asset Intervals
For static assets there are two GPS reporting intervals available. One is used while the GPS-207DC is on 
external power and the other is used while the GPS-207DC is on internal battery power. While on 
external power the GPS-207DC can be programmed to report its position as frequently as every 5 
minutes. However, while on internal battery power, it can only be programmed to report much less 
frequently. This is done so that the internal battery charge is not depleted quickly.
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Parameters

Figure 42: Static Asset Reporting Intervals - 
External Power Source

Figure 43: Static Asset  Reporting Intervals - 
Internal Battery Power



4.5.3.3 In Motion Intervals
If the GPS Reporting Type is set to In Motion there are four intervals for reporting position. Stationary 
and in motion, while on external power, and stationary and in motion, while on internal battery (Figure
41: GPS Configuration, In Motion Asset Parameters).

As with a static asset, the stationary reporting intervals (stationary or in motion) while on external power 
can be as low as five minutes. 

The stationary reporting intervals while on battery are not as aggressive in order to preserve the life of the 
battery. However, the in motion reporting intervals can be as low as 30 minutes.

4.5.4 Send Config
Once all of the parameters are defined the GPS207DC can be programmed. This is done by clicking on 
the Send Config button. As the GPS207DC is programmed the progress bar to the right of the Send 
Config button will display the progress.
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Figure 45: GPS207DC Progress Bar

When the programming process is complete the following dialog will be displayed

Figure 46: Programming Complete
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6.0 Support

If you need help, we are easily accessible ….

Telephone: Call 407-679-9440, and ask for product support.

Fax: 407-679-8110

Email:  support@ceswireless.com

Skype: Please email support@ceswireless.com to obtain your currently assigned support engineer’s 
Skype address.

Product support may ask you to E-MAIL a copy of the programmed parameters to us for analysis. To do 
this, go to FILE on the DP-1000S main menu, and click on SAVE AS. Note the path to the saved file in 
the save file dialog. Attach this file to an e-mail and send it to you product support representative or to the 
e-mail address noted above.

Product support may ask you to PRINT a copy of the programmed parameters, and fax to for analysis. To 
do this, go to FILE on the DP-1000S main menu, and click on PRINT. 

Support Resources: www.ceswireless.com

FTP Site: Please go to www.ceswireless.com and register for an FTP site User Name and Password 
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